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1 Introduction 
LaTeX is open-source software that can be used for word processing. 

Whereas in most word processing programs (e.g., Microsoft Word), one click is all it takes 
to change the font, colour, or style of the text, to achieve the same results with LaTeX, one 
has to resort to a specific code and syntax.  

 

Figure 1: A Microsoft Word document 

 

 

Figure 2: The same document in LaTeX 

This approach, at first glance more complex, offers granular control over the document’s 
structure. From simple text formatting to complex layouts of mathematical equations, 
graphs and three-dimensional representations, LaTeX enables highly customized, 
professional-quality results. For this very reason, it is a suitable tool for creating technical 
and scientific documents, such as academic papers or dissertations.  
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In this guide, we will not examine the full range of features that LaTeX makes available to 
its users, but we will focus on one particular aspect: the creation of bibliographies.  

The goal is to provide practical and concise information for writing accurate bibliographies, 
such as those required for theses, by taking advantage of the tools provided by LaTeX. 

 

1.1 How to get it 
LaTeX is available free of charge. You can download it locally using a LaTeX distributor 
(for MacOs MacTeX; for Windows MikTeX o TeXLive), i.e., a complete software package 
that provides everything needed to install, configure, and update the program.  

You can also individually download the components you need to start working with LaTeX 
by browsing the CTAN (Comprehensive TeX Archive Network) servers, the most 
comprehensive and reliable resource for everything related to the world of LaTeX. 

 

Figure 3: CTAN’s homepage 

Alternatively, you can use LaTeX directly online on platforms like Overleaf and Papeeria 
without installation. This choice allows all the advantages of cloud environments 
(automatic backup, access from any device, integration with other services, etc.). It 
relieves the user of the burden of updating LaTeX and its packages periodically.  

The explanations and examples in this guide are based on Overleaf.  
 

  

https://www.tug.org/mactex/mactex-download.html
https://miktex.org/download
https://www.tug.org/texlive/windows.html
https://www.ctan.org/
https://www.overleaf.com/
https://papeeria.com/
https://papeeria.com/
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1.1.1 Registration on Overleaf 
To use Overleaf, an account must be created (accreditation using Google credentials, 
either personal or institutional, is also possible1). 

 

1) www.overleaf.com 
 

2) From the homepage, select “Sign up with Google.” 

 

3) Choose an account between personal and institutional accounts. 

 

4) Take note of the guidance on data sharing. 

 
1 Please note that the institutional account is valid temporarily and only remains in operation for three years 
after the degree is awarded; therefore, it is important to transfer your files and projects before it expires. 
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5) Skip the page inviting you to try the premium version by clicking “Skip.” 

 

6) Fill in the fields with your data or skip by clicking “Skip.” 

 

Welcome to Overleaf! 
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1.1.2 Create a new project on Overleaf 
1) Select “Create a new project.” 

 

2) Select which type of project; choose “blank project.” 

 

3) Give your project a name. 

 

4) The document is ready to be filled out! 

 

Figure 4: Home page with split between text editor (left) and output preview (right) 

Please Note: You must click “Recompile” to display the written code’s graphical product 
on the screen’s right side! 
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2 Basic elements 
A flat document in LaTeX is divided into two main parts: a preamble and a body.  
Commands must be entered in both; these all have the same basic structure: 
\commandname [optional_repeatable_topic]{mandatory_topic}. 
In addition to simple commands, it is possible to set up working environments by 
combining a \begin{} and \end{} commands. 

  

2.1 The preamble 
The preamble defines: 

• The class of the document, i.e., its type. It determines by default margins, fonts, 
spacing, and title position. The main classes are: article, book, report.  
The declaration of the document class is mandatory and done through the 
command \documentclass{class_document} command. 

• Packages available are “extensions” of the basic program created to meet special 
needs. To indicate to the program that it also draws on instructions in packets, 
these are introduced using the command  
\usepackage{package_name}. 

• Data on the author, title, and date of the paper. 
\author{first_last name} 

\title{title} 

\date{year} 

 
In the presence of multiple authors, use \and:  

\author{Marcellini \and Sbordone}. 

 

2.2 The body 
The document’s body coincides with what is enclosed within the document environment. 
\begin{document} 

… 

\end{document} 

Within this macroenvironment, you place everything that is to appear in the output.  

 

 

For a more complete and comprehensive discussion, please refer to the material listed in 5 
Bibliography and webliography and specifically to the resources Learn LaTeX e LaTeX: 
writing documents like a pro.  

  

https://www.learnlatex.org/it/lesson-01
https://www.youtube.com/watch?v=QY2zdhSY48M
https://www.youtube.com/watch?v=QY2zdhSY48M
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3 Creation of the bibliographic database 
A bibliography is a comprehensive list of resources consulted while writing a paper.  

In Latex, the bibliography can be managed internally to the input file (in our case, the 
main.tex, i.e., the file in which we write the source) through thebibliography workspace or 
externally, through the creation of a bibliography database, i.e., a file with the extension 
.bib inside which we import all the information that the program will use to build our 
bibliographic records. This approach is generally preferred for two reasons: it facilitates the 
reuse of record items in different projects and ensures consistent formatting of citations 
and the final bibliography. 

3.1 Create a (*.bib) file 
Go to the left column and select “New File.” 

 
 

When renaming it, remember to change the default extension (which is .tex) with “.bib.” 

 

Once created, the bib file is enriched with bibliographic records that can be compiled 
manually or imported from databases, archives, or search engines.   



9 
 

 

 

3.2 Compiling a bibliographic record 
Information is organized in a pattern that varies according to the resource type.  

Each record is identified by a unique citation key that allows information about the 
resource to which that key refers to be automatically retrieved in the text. Citation keys are 
freely customizable, even in the case of imported records.  

Record fields are divided into mandatory and optional. 

The documentary types mainly used are article, book, incollection, misc. 

 

The article is the journal article. 

 

@article{citation-key, 

author={author_name}, 

title={article_title}, 

journal={journal_name}, 
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year={publication_year} 

} 

Optional fields: volume, number, pages, month, notes. 

 

The book is a monograph resource. 

 

@book{citation-key, 

author={author_name}, 

title={book_title}, 

publisher={publisher_name}, 

year={publication_year}  

} 

Optional fields: volume or number, series, address, edition, month, notes. 

The author can be replaced by the editor editor={editor_name}. 

The author and editor are alternatives; they cannot coexist in the same record. 

The book typology is also used in databases to describe doctoral dissertations instead of 
the more specific @phdthesis. 

 

Incollection is the part of a book with its own significant title (for example, an author’s 

contribution to a monographic volume). 
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@incollection{citation-key, 

author={author_name}, 

title={chapter_title}, 

booktitle={book_title}, 

publisher={publisher_name}, 

year={publication_year} 

} 

Optional fields: editor, volume/number, series, type, chapter, pages, address, edition, 
month, notes. 

In addition to incollection, there is also inbook, which indicates the part of a book 

that may lack a meaningful title, such as a chapter, section, or range of pages. 

 

Misc describes residual resources, i.e., those not attributable to the other types. It is, 

therefore, used to describe online resources (websites). 

 

@misc{citation-key, 

author={author_name},  

key={alphanumeric_string} 

} 

The author and key fields are alternate. 

Optional fields: author, title, howpublished, month, year, notes, URL. 

We point out that conference proceedings are often treated as periodicals because of their 
regular recurrence. Accordingly, the contributions in the volumes reporting them are 
described as articles and not as inproceedings. 
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3.3 Import individual bibliographic records 
You can feed a file (*.bib) by importing records downloaded from catalogues and 
databases. These include OneSearch, ArXiv, MathSciNet, and Google Scholar.  

OneSearch 
Click first on “Export Bibtex,” then on “Download.” 

 

Copy and paste the contents of the downloaded .txt file into your file (*.bib). 

In records downloaded from OneSearch, it is essential to verify the correctness of the data 
reported in the fields: 

• author in the case of resources with multiple authors, check that they all appear; 

• title and booktitle when both present in an @book record, delete booktitle; in 

the title field, delete the responsibility statements given after the slash, including the 
symbol. 

https://onesearch.unifi.it/primo-explore/search?vid=39UFI_V1&lang=it_IT
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ArXiv 

Go into the record of interest and click on “Export BibTeX Citation” in the menu on the 
right. 

 

 

  

https://arxiv.org/
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MathSciNet 

Go to the record of interest and click on “Cite.” 

 

 

GoogleScholar 

Click on “Cite.” 

 

Select “Bib TeX.” 

 

https://mathscinet.ams.org/mathscinet/publications-search
https://scholar.google.com/
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3.4 Importing a bibliography from an RMS  
In case you routinely use an RMS - Reference Management Software (EndNote, 
Mendeley, Zotero, JabRef) to manage your bibliographic references, you will be able to 
export a selection of records or the entire bibliography in (*.bib) format and transfer it to a 
LaTeX project. 

 

EndNote 

1) Connect to the online version of MyEndNoteWeb and log in. 
2) Choose the Format tab. 

 

 

3) Select the “Export References” sub-tab. 

 

 

4) From the pull-down menu, choose which records to export. 

http://www.myendnoteweb.com/
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5) In the Export style field, select BibTex Export. 

 

 

Mendeley 

1) Connect to Mendeley and log in with your credentials. 
2) Select Library in the upper right corner. 
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3) Check the first box on the top left to select all the records present and click on 
Export in the bottom centre. 

 

 

 

4) Choose the BibTeX(*.bib) format. 
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Zotero 

1) Once the application is open, click on File > Export Library... 

 

 

2) Select the BibLaTeX format. 
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JabRef 

In JabRef, two distinct paths are followed to export selected records or the entire 
bibliography. 

• For a selection of records, after locating them, click on File > Export >Save selected 
as plain BibTeX... 

 

• To export the entire bibliography instead, select File > Save library as... 

 

• Choose the destination folder and file name. The default format will be a Bibtex 
library file (*.bib). 
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3.4.1 Upload the file (*.bib) downloaded from the RMS to Overleaf 

• Click on “Upload” in the upper left corner. 

 

• Click on “Select files” and select the files of interest. 
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4 Creating the bibliography 
Once the bib file has been created, the best way to link it with your project’s main file is 
through the use of a2 package (i.e., a pre-built set of commands that Overleaf will draw on 
to perform operations in addition to the basic ones) designed specifically for managing 
bibliographies. There are two options: Natbib and Biblatex. 

4.1 Biblatex 
The biblatex package is of more recent development than Natbib and is generally 
considered more powerful and flexible. One of its main advantages is better typographical 
rendering in cases where non-ASCII characters, such as accented vowels, umlauts, and 
cedilla, are present in the document references.  

Please note: In order for biblatex to work at its best, before loading it into the preamble, it 
is strongly recommended also to load   

• a package to adapt the formatting produced by LaTex to the language of the 
document. The choice is between:  

o babel (recommended, for more concise syntax):  

\usepackage[secondary language, main language]{babel}; 

o polyglossia:  
\usepackage{polyglossia}  

\setmainlanguage{main language}  

\setotherlanguages{secondarylanguages} 

• the csquotes package, which is used to adapt the use of quotation marks to the 

language in use: 
\{usepackage[autostyle,italian=guillemets]{csquotes}  

 
 
Load biblatex, inserting in the preamble:  
\usepackage[optional_topics]{biblatex} 

Optional topics include: 

• backend: biblatex was developed to work with the biber backend software, but 

it can also be used with bibtex or bibtex8. Just specify the intention in the 

value of this topic. If the argument is omitted, biber will be used by default. 
• style: the value of this argument determines the style of the bibliography. The 

most commonly used styles in STEM area publications are numeric and 

alphabetic. If the argument is omitted, numeric will be used by default. 

Ex. \usepackage[backend=biber, style=alphabetic,]{biblatex} 

To link the bibliographic database to the document, enter in the preamble, taking care to 
specify the extension: \addbibresource{filebib.bib} 

Within the body of the document, at the point where you want to print the bibliography, 
enter: \printbibliography 

 
2 The packages are saved and available on Overleaf's servers, so it is sufficient for the end user to call them 
up in the source, without downloading them locally. 
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Below are the commands for making citations in the document: 

• \cite{label} prints the reference with the citation style you chose in the 

preamble. In case none is chosen, the default style is numeric; 
• \citeauthor{label} prints the name of the author of the reference; 

• \citetitle{label} prints the title of the reference; 

• \footcite{label} prints the reference in a footnote; 

• \footfullcite{label} prints in a footnote the reference as it appears in 

the final bibliography;  
• \nocite{*} causes all references contained in the bibliographic database to 

appear in the final bibliography, even those not directly cited in the text of the 
paper. 
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Figure 5: Output of citation commands - Biblatex. 

If you want to insert text before or after the citation, these commands accommodate two 
optional arguments in square brackets. If only one of the two arguments is declared, it is 
interpreted as a post-citation (e.g. ch. 3). If you want to insert only a pre-citation (e.g., cf.), 
you must follow up with a pair of blank squares. 

\cite[pre-citation][post-citation]{label}. Ex. [cf. Beretta and 

Francini, 2003, chap. 3] 
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4.2 Natbib 
Natbib remains the best option in case it is necessary to maintain compatibility with 
documents produced before the implementation of Biblatex (2006).  

 

Insert in the preamble \usepackage []{natbib} 

Enter \bibliographystyle{plainnat} in the body of the document to set the 

formatting style of the bibliography. Plainnat is the default bibliographic style. 

Before \end{document} enter \bibliography{filebib} to determine the link to the 

file (*.bib). Multiple files (*.bib) can be referenced at the same time by separating their 
names with a comma.  
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Most common citation commands:  

- \citep{label}, prints the reference in parentheses. Ex. [Lellis and Focardi. 2023] 
- \citet{label}, prints the author out of parentheses, and the year in parentheses. E.g. 
Gentili [2022] 
- \citealt{label}, prints author and year out of parentheses. E.g. Magnanini and 
Poggesi 2024. 
- \citeauthor, prints only the author. E.g. Beretta and Francini. 
- \nocite{*}, causes all references contained in the bibliographic database to appear in 
the final bibliography, even those not directly cited in the paper. 

 

In case you want to insert text before or after the citation, these commands accommodate 
two optional arguments in square brackets. If only one of the two arguments is declared, it 
is interpreted as a post-citation (e.g. ch. 3). If you want to insert only a pre-citation (e.g., 
cf.), you must follow up with a pair of blank squares. 

- \cite[pre-citation][post-citation]{label}. Ex. [cf. Beretta and Francini, 

2003, chap. 3]. 

 

Figure 6: Output of citation commands - Natbib. 

Please note It is possible that in some of the templates currently in use in the School of 
Science, for example, the Computer Science one, it has been chosen not to make use of 
packages but to take advantage of the basic functionality of Latex (BibTeX) to manage the 
bibliography in an essential way.   

In this case the user will find, at the end of the main file (before \end{document}), only the 
commands: 

\{bibliographystyle{style_name} 
\bibliography{bibliography.bib} 

The first to define the style to be adopted for the bibliography, the second to create the link 
between the main file (the Thesis.tex) and the bibliographic database (Bibliography.bib). 



26 
 

4.3 Thebibliography 
It is also possible to manage the bibliography entirely within the main document, that is, 
without resorting to the use of a .bib file, thanks to thebibliography, which is not a package 
but a working environment, delimited by the following commands: 

\begin{thebibliography}{99}  

... 

\end{thebibliography} 

The opening command has a mandatory argument that handles the extent of indentation 
of bibliography entries. In numerically ordered bibliographies, it is conventionally assigned 
the value 99, as shown above. However, the topic also accommodates alphanumeric 
strings. 

Each bibliographic reference must be introduced by the command \bibitem{label}, 

where the value of the argument between staples will be a unique alphanumeric string for 
each reference. With this unique string, you can use the command \cite{label} to 

retrieve the resource to which it refers in the text of the document. 

 

 

Figure 7: Output of the previous image source. 

Resorting to thebibliography environment is an unsustainable solution when you have 
large bibliographies. It involves manually writing the bibliographic references for each 
resource. Compared to using an external bibliographic database, it is a more labour-
intensive and error-prone choice. 
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5 Bibliography and webliography 
Webliography and online open-access resources 

• LaTeX official website  

• Learn LaTeX Concise course on the fundamentals of LaTeX, structured in 16 
lessons in Italian.  

• LaTeX: writing documents as a pro by Dr. Enrico Mensa, PhD (University of Turin), 
video lecture on YouTube 

• LaTeX Tutorial structured in short lessons in English  

• LaTeXpedia by Lorenzo Pantieri  

• The art of writing with LaTeX by Lorenzo Pantieri (2008) 

• LaTeX for the impatient by Lorenzo Pantieri (2008) 

• LaTeXTutorial by Fabio Durastante (University of Pisa; A.Y. 2021-2022)  

• Little Guide to LaTeX from Catholic University  

• BibLaTeX Cheat Sheet by C. F. Rees, 2017 

• BibTeX Official website  

• Outline of document types and fields for creating bibliographic records 
o MIT Outline - Massachusetts Institute of Technology of 2012  
o A. Roberts Outline  

• Examples of the citation styles that can be set in BibTeX  

• Composing bibliography in LaTeX: biblatex and bibliographic management software 
by Filippo Vomiero, 2021.  

• The biblatex package: programmable bibliographies and citations by P. Kime, M. 
Wemheurer, P. Lehman, 2024.  

• Bibliography management in LaTeX by Overleaf  

• Bibliography management with Natbib by Overleaf  

• Natbib bibliography styles by Overleaf  

• Pérez, Álvarez and Abel, Carlos and Baquero Torres, Efrén Ricardo. Matemáticas 
con LaTeX: elaboración de gráficos y textos. Bogotá: Escuela Colombiana de 
Ingeniería Julio Garavito Editorial, 2020. Language: Spanish. Title translation: 
Mathematics with LaTeX: graph and text processing. 
Available in open access on the Escuela Colombiana de Ingenieria Julio Garavito 
repository.  

• doi2bib website that allows you to extract a bibliographic record in BibTeX format by 
entering a doi or arXivID  

• CTAN: The Comprehensive TeX Archive Network  

• TUG: TeX Users Group  
  

https://www.latex-project.org/get/
https://www.learnlatex.org/it/
https://www.youtube.com/watch?v=QY2zdhSY48M
https://latex-tutorial.com/tutorials/
http://www.lorenzopantieri.net/LaTeX_files/LaTeXpedia.pdf
http://www.lorenzopantieri.net/LaTeX_files/ArteLaTeX.pdf
http://www.lorenzopantieri.net/LaTeX_files/LaTeXimpaziente.pdf
https://people.cs.dm.unipi.it/limco/2021-22/biblio/LaTeXTutorial.pdf
file://///olmo.unifi.it/sba_bs_shared/Services%20Reference/Istructions/LaTex/-%09https:/www.dmf.unicatt.it/~musesti/CourseLaTeX/LatexPiccolo-it.pdf
https://tug.ctan.org/info/biblatex-cheatsheet/biblatex-cheatsheet.pdf
https://www.bibtex.org/
https://web.mit.edu/rsi/www/pdfs/bibtex-format.pdf
https://www.andy-roberts.net/res/latex/bibentries.pdf
https://www.cs.stir.ac.uk/~kjt/software/latex/showbst.html
https://www.guitex.org/home/images/doc/GuideGuIT/bibliografia.pdf
https://ctan.mirror.garr.it/mirrors/ctan/macros/latex/contrib/biblatex/doc/biblatex.pdf
https://www.overleaf.com/learn/latex/Bibliography_management_in_LaTeX
https://it.overleaf.com/learn/latex/Bibliography_management_with_natbib#Reference_guide
https://it.overleaf.com/learn/latex/Natbib_bibliography_styles
https://repositorio.escuelaing.edu.co/handle/001/1689
https://repositorio.escuelaing.edu.co/handle/001/1689
https://www.doi2bib.org/
https://www.ctan.org/
https://tug.org/
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Materials available at the Mathematics library 

• Syropoulos, Apostolos and Tsolomitis, Antonis and Sofroniou. Digital typography 
using LaTeX. New York: Springer, 2003. 
(Loan) Collocation: Monographs 33B 1854 Barcode: UFI472388 

• Goossens, Michel and Mittelbach, Frank and Samarin, Alexander. The LaTeX 
companion.  Reading Mass., etc.: Addison-Wesley, 1994.  
Copy 1 (Loan) Collocation: Monographs MA33 B00 01554 Barcode: MA001005347 
Copy 2 (Loan) Collocation: Santa Verdiana C7 GOOM Barcode: M1000001509 

• Lamport, Leslie. LaTeX: a document preparation system, user’s guide and 
reference manual. Reading: Addison-Wesley, 1994. 
(In-house reading only) Collocation: Monographs MAGENERST1BIBL000004 
(open shelf room) Barcode: MA001006026 

• Grätzer, George. Math into TeX: a simple introduction to AMS-LaTeX. Boston : 
Birkhäuser, 1993. 
(In-house reading only) Collocation: Monographs MAGENERST1BIBL000002 
(open shelf room) Barcode: MA001003441 

• Vulis, Michael. Modern TeX and its applications. Boca Raton : CRC Press, 1993. 
Copy 1 (In-house reading only) Collocation: MAGENERST1BIBL000003 (open 
shelf room) Barcode: MA001003633 
Copy 2 (Loan) Collocation: Santa Verdiana C7 VULM Barcode:M1000001091 

• Lamport, Leslie. LaTeX: a document preparation system. Reading, Mass: Addison-
Wesley, 1986. 
(In-house reading only) Collocation: MAGENERST1BIBL000001 (open shelf 
room) Barcode: MA001002100 

 

Materials available in our institution 
(published in the last ten years and sorted by decreasing year of publication) 

Physical books 

• Higham, Nicholas J. Handbook of Writing for the Mathematical Sciences. 3. ed. 
Philadelphia: SIAM, 2020. 
Available at the Sesto F.no Science Campus Library: location General 
Monographs Collection 808.066 HIGHNJ, barcode UFI283123. 

• Datta, Dilip. LaTeX in 24 Hours A Practical Guide for Scientific Writing. 1st ed. 
Cham: Springer, 2017. 
Available at the Engineering Library: collocation Room - 686.225 LATEX 
DA2017, barcode UFI75939. 

Digital books 

• Öchsner, Marco and Öchsner, Andreas. Advanced LaTeX in Academia: 
Applications in Research and Education. Cham, Switzerland: Springer International 
Publishing, 2022. Permalink to the record 

• Datta, Dilip. LaTeX in 24 Hours A Practical Guide for Scientific Writing. 1st ed. 
Cham: Springer, 2017. Permalink to the record 

• Grätzer, George. More Math Into LaTeX. 5th ed. Cham : Springer International 
Publishing, 2016. Permalink to the record 

 

https://onesearch.unifi.it/primo-explore/fulldisplay?docid=39sbart_almae71122568060003302&context=L&vid=39UFI_V1&search_scope=BooksJournals&tab=default_tab&lang=it_IT
https://onesearch.unifi.it/primo-explore/fulldisplay?docid=39sbart_almae7165989700003302&context=L&vid=39UFI_V1&search_scope=BooksJournals&tab=default_tab&lang=it_IT
https://onesearch.unifi.it/primo-explore/fulldisplay?docid=39sbart_almae7163999070003302&context=L&vid=39UFI_V1&search_scope=BooksJournals&tab=default_tab&lang=it_IT


29 
 

Materials to be requested with regional ILL3 
(published in the last ten years) 

• Refish, Salah. Utilizzo di Latex attraverso Overleaf Online. Chinasau : Sciencia 
Scripts, ©2022. 
Available at the Library of Mathematics, Computer Science and Physics, 
University of Pisa (Former Marzotto Complex, Largo Bruno Pontecorvo 3 - 56127 
Pisa): location Informatics I. 7.2 r50 INF, barcode MIF045727. 

 

Materials to be requested with national ILL4 
(published in the last ten years and sorted by decreasing year of publication) 

• Mureddu, Leonardo. Editoria con LaTeX : guida al più diffuso sistema tipografico 
Open Source. Cagliari: Xedizioni, 2023. 
Available at:  

o Salaborsa Library - Bologna (BO) - +39 0512194400 
bibliotecasalaborsa@comune.bologna.it  
Bibliographic record in the local catalogue 

o Interdepartmental Scientific Library of the University of Modena and Reggio 
Emilia - Modena (MO) - +39 0592055489 - bsi@unimo.it  
Bibliographic record in the local catalogue 

• Mittelbach, Frank and Fischer, Ulrike. The LATEX Companion: Parts I & II. - 3. ed. - 
Boston : Addison-Wesley Professional, 2023. 
Available at: 

o 'Leon Battista Alberti' Central Library on the Cesena Campus. Central 
Section - Cesena (FC) - +39 0547338315 - bibliotecacesena.info@unibo.it 
Bibliographic record in the local catalogue 

o Library of the Department of Mathematics and Computer Science, University 
of Ferrara - Ferrara (FE) - +39 0532974007 - biblioteca.matematica@unife.it 
Bibliographic record in the local catalogue 

• Kottwitz, Stefan. LaTeX graphics with TikZ : a practitioner’s guide to drawing 2D 
and 3D images, diagrams, charts, and plots. - Birmingham ; Mumbai : Packt 
Publishing, 2023. 
Available at the Library of the Department of Mathematics and Computer Science, 
University of Ferrara - Ferrara (FE) - +39 0532974007 - 
biblioteca.matematica@unife.it 
Bibliographic record in the local catalogue 

• Mangoni, Alessio. Manuale pratico per Latex. - s.l. : s.n., 2020. 
Available at the ‘Giovanna Mancini’ Humanities-Biosciences Campus Library - 
Teramo (TE) - +39 0861266419 - bibliotecapoloumanistico@unite.it 
Bibliographic record in the local catalogue 

  

 
3  For interlibrary loan within the Tuscany Region, no financial contribution is required from the user.  
4 To access this service, the user may be required to pay a financial contribution depending on whether or 
not the institution holding the document has an agreement with the University of Florence. 

mailto:bibliotecasalaborsa@comune.bologna.it
https://sol.unibo.it/SebinaOpac/resource/editoria-con-latex-guida-al-piu-diffuso-sistema-tipografico-open-source/UBO8628145
mailto:bsi@unimo.it
https://www.bibliomo.it/SebinaOpac/resource/editoria-con-latex-guida-al-piu-diffuso-sistema-tipografico-open-source/MOD02632768
mailto:bibliotecacesena.info@unibo.it
https://sol.unibo.it/SebinaOpac/SebinaYOU.do?q=BID:UFE1052995
mailto:biblioteca.matematica@unife.it
http://opac.unife.it/SebinaOpac/Opac.do?q=BID:UFE1052995
mailto:biblioteca.matematica@unife.it
http://opac.unife.it/SebinaOpac/Opac.do?q=BID:UFE1049453
mailto:bibliotecapoloumanistico@unite.it
https://opac-bia.nexusit.it/it/collettivo/record/ABR0009361
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• Griffiths, David F. and Higham, Desmond J. Learning LaTeX.- 2nd ed. - 
Philadelphia : Siam, c2016. 
Available at the Interdepartmental Library of Mathematics, Physics, Astronomy and 
Computer Science - Mathematics Section - Alma Mater Studiorum - University of 
Bologna - Bologna (BO) - +39 0512094411 - dipmat.biblioteca@unibo.it 
Bibliographic record in the local catalog 

 

Purchase Suggestions 
(published in the last five years and sorted by year of publication in descending order) 

• Kottwitz, Stefan. LaTeX Cookbook: Over 100 Practical, Ready-To-Use LaTeX 
Recipes for Instant Solutions. 2nd ed. Birmingham: Packt Publishing, Limited, 2024. 
Paperback: 9781835080320 
Ebook: 9781835082294   

• Grätzer, George. Text and Math into LaTeX. 6th ed. New York: Springer, 2024. 
Paperback: 9783031552809 

• Goossens, Michel. The LATEX Graphics Companion: Tools and Techniques for 
Computer Typesetting, 2nd ed. Mϋnchen: Lehmanns Media GmbH, 2022. 
Paperback: 9783965433038 

• Kottwitz, Stefan. LaTeX Beginner’s Guide: Create Visually Appealing Texts, 
Articles, and Books for Business and Science Using LaTeX. 2nd ed. Birmingham: 
Packt Publishing, Limited, 2021. 
Paperback: 9781801078658 
Ebook: 9781801072588 
Ebook (pdf) 2023 ed.: 9781847199867 

• Kumar, S. S. Latex basics. USA: Mercury Learning Information, 2021. 
Paperback: 9781683925132 

• Priya, Mohana. Let’s dive into LaTeX: for professional documentation, LAP Lambert 
Academic Publishing, 2020. 
Paperback: 9786202671484 

• Wilson, Peter. Glisterings: LaTEX and other oddments, TeX user group, 2020. 
Paperback: 9780982462621 

• Mishra, Jyoti and Mishra, Ashish. Fundamentals of Latex. LAP Lambert Academic 
Publishing, 2019.  
Paperback: 9786200323187 

 

  

mailto:dipmat.biblioteca@unibo.it
https://sol.unibo.it/SebinaOpac/SebinaYOU.do?q=BID:UBO4377031
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6 LaTeX style packages in use at Unifi 
 

- Corporate image Package to be uploaded to Overleaf for presentation creation 
(slides) 

 

School of Mathematical, Physical and Natural Sciences 

• Bachelor of Science in Mathematics, thesis template prepared by Prof. Fornasiero,  
the template uses the biblatex package 

• Bachelor of Science in Computer Science, thesis template; the template does not 
use bibliography packages. It relies on bibtex base 

• Bachelor of Science in Physics and Astrophysics, Unifith package by Francesco 
Biccari downloadable from CTAN; template does not include commands for 
bibliography 

• Master’s degree in Software: Science and Technology, thesis template; the 
template uses the natbib package  

• Master’s degree in Data Science, Scientific Computation & Artificial Intelligence, 
thesis template; template uses natbib package 

 

School of Engineering  

• Master’s Degree in Energy Engineering, thesis template; the template uses the 
natbib package 

• Bachelor of Science in Computer Engineering, thesis template; template does not 
use packages for bibliography relying on bibtex base 

 

School of Economics and Management 

• Master’s Degree in Statistics and Data Science, thesis template; this is the Unififth 
package by Francesco Biccari; the template does not include commands for 
bibliography management 

https://www.unifi.it/sites/default/files/2024-07/unifi_latex_overleaf.zip
https://www.matematica.unifi.it/vp-17-per-laurearsi.html
https://drive.google.com/file/d/1rsmMI3zIzEba96eQkVzimysPKtMdkzqD/view?usp=sharing
https://www.informatica.unifi.it/vp-187-stile-latex-per-la-tesi.html
https://www.fis-astro.unifi.it/vp-17-per-laurearsi.html
https://ctan.org/pkg/unifith
https://www.sst.unifi.it/vp-17-per-laurearsi.html
https://www.datascience-cs-ia.unifi.it/vp-17-per-laurearsi.html
https://www.ing-enm.unifi.it/vp-123-format-presentazione-e-tesi-di-laurea.html
https://www.ing-enm.unifi.it/upload/sub/template_latex_mem.zip
https://www.ing-inl.unifi.it/vp-17-per-laurearsi.html
https://www.ing-inl.unifi.it/upload/sub/Template_tesi.zip
https://www.sds.unifi.it/vp-17-per-laurearsi.html
https://biccari.altervista.org/c/informatica/latex/unifith.php

